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A message fromNC— 
Our next club year starts after we elect 
officers and directors at the April meet-
ing. It will be here before we know it and 
before we are ready for it if we do not start 
planning now. This message is intended to 
start provoking constructive thoughts on 
how our club can be better next year than 
it is now.
	 We have the foundation for a wonder-
ful club: A dedicated and capable group  
of officers and directors, a great website,  
a fantastic newsletter, and excellent  
programs. Everyone’s willingness to help 
out makes the officer’s job  much easier. 
What can be better?
	 Despite how great we are, our mem-
bership has grown only slightly – just 
about enough to keep pace with drop 
outs. Why are we not growing?  We could 

easily seat twice our average attendance 
by setting the room up auditorium style.
	 We do not do much publicity. If we had 
a publicity volunteer, there are venues we 
could use without extra expense to get 
the word out. ANY VOLUNTEERS? ARE YOU 
GIVING CLUB BUSINESS CARDS TO APPLE 
USERS YOU MEET? iPads and iPhones are 
selling much faster today than MACS of all 
descriptions. We are not especially strong 
in covering these iOS devices. Do we need 
more programs in this area? Do YOU,  have 
the ability to help us provide programs, 
tech tips, and or workshops on iOS and 
iOS apps? (or anything MAC for that  
matter) If so, let the board know. If you 
would like for us to start offering this ma-
terial let us know. It would not necessarily 
reduce our MAC programs. For example: 
maybe we could continue offering MAC 

workshops on the third Saturday and  
iOS workshops on a different Saturday. 
It would require someone willing to step 
up and do it. During regular meetings we 
could break into separate groups for tech 
tips: one for MACs and one for iOS. These 
are not plans; these are thoughts to get 
reactions. Please react!
	 I want to step down from the presi-
dency and leave the new president with a 
lot of member input as to what is wanted, 
who is willing to help, etc. Please think 
about the ideas presented in this article 
and any others you may come up with.  
	 HOW TO RESPOND—Send your 
feedback to ocalamug@gmail.com.   
It will pass  to the entire board for discus-
sion. Thanks for your cooperation and 
assistance.  
—NC Sizemore,  President
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CONVERT YOUR PROGRAMS ON CDs TO DMG
A help tip by Phil Davis

A U.S. Apple factory may be 
robot city— By Patrick Thibodeau, 
Computerworld

Apple’s planned investment of $100 mil-
lion next year in a U.S. manufacturing 
facility is relatively small, but still impor-
tant. Apple has the money, talent and 
resources to build a highly automated 
factory that turns out products that are 
potentially cost competitive with those it 
now makes in China.
	 Apple has already demonstrated its 
use of automation in the manufacturing 
of some of its MacBook products, includ-
ing the MacBook Air. It was built with 
what the company calls its “unibody de-
sign” that was crafted from a single sheet 
of aluminum.
	 A 2009 Apple video of its unibody 
manufacturing process has glimpses of 
highly automated systems shaping the 
metal. In it, Jonathan Ive, Apple’s senior 
vice president of design, talked about 
the manufacturing process. “Machining 
enables a level of precision that is just 
completely unheard of in this industry,” 
he said.
	 Apple has the know-how to build one 
of the world’s most modern plants, and 
if it succeeds, it could influence others 
to build in the U.S. But success will mean 
holding down costs, and to do so, Apple 
will likely rely heavily on automation, say 
analysts and manufacturers.
	 Larry Sweet, the CTO of Symbotic, 
which makes autonomous mobile robots 
for use in warehouse distribution, de-
scribed a possible scenario for the Apple 
factory.
	 First, a robot loads the aluminum 
block into the robo-machine that has 
a range of tools for cutting and drilling 
shapes to produce the complex chassis 
as a single precision part, Sweet said.
	 A robot then unloads the chassis and 
sends it down a production line where 
a series of small, high-precision, high-
speed robots insert parts, secured either 
with snap fit, adhesive bonds, solder, and 
—Continued on page 3

Inspired by: The End is Nigh (For Your Optical Drive, at Least), By Carl Grasso 

Those of you who have recently purchased new iMacs or Laptops that no longer 
have a CD/DVD capability are confronted by the question “What do I do with all those 
programs that are on CDs or DVDs?”

Whether you like it or not this is the wave of the future so we might as well learn how 
to ride the wave, just like we did with the demise of floppies and other obsolete  
storage options. This is probably a good thing since optical discs are easily damaged 
and do not store as much data as modern flash drives.

Most software companies now offer download options for nearly everything and, 
with the growing access to high-speed Internet services, you don’t spend all day  
getting your new programs. Moreover, the reliance of Apple on the use of the Mac 
Apple Store for distribution of it’s software makes it easy to keep your apps up to date 
on all your computers.

However many of us still have programs that are on physical media so we need to 
think about retaining those programs that still actually work on Mountain Lion in 
another format.

Here are some options to consider.

1.	 Let go of the older software (much of it won’t work on Mountain Lion)

2.	 Transfer applications that work using Migration Assistant

3.	 If this doesn’t work, either purchase an external optical drive or use Disc Sharing to 
hijack the optical drive of another Mac and load the software into your new machine.

4.	 Convert your physical media to the the ubiquitous modern software delivery 
tool called a disk image which can be easily moved, mounted, and accessed on any 
machine.

1.	 Insert the optical disc (CD or DVD) into your Mac’s optical drive.

2.	 Open Disk Utility (in Utilities)

3.	 You’ll see the disc listed on the left hand side of the window; select it and then 
click on the New Image icon

4.	 Select a location where you’d like the disk image to be saved. I strongly 
recommend a place that will be included in your regular backup. Remember, the disk 
image is as vulnerable as any other file stored on your hard drive. The eventual loss 
of optical drives (for example: Mac’s SuperDrive) from computers should stress the 
importance of doing backups on a regular basis.

5.	 Wait until the image is created, then eject your disc. Double click the new DMG file 
created by Disk Utility to verify that it opens.

You can keep a big software library in a relatively small space this way, and no need 
for an optical drive for any of it.

A side note— Just to avoid emails saying I’m spelling disc inconsistently as disk, or vise versa, a 
disc refers to optical media such as a CD or DVD. Disk refers to magnetic media like your hard 
drive or a floppy disk (everyone remember those?).

http://blog.smalldog.com/techtails/tt844/?utm_source=newsletter&utm_medium=email&utm_campaign=tech-20121107
http://en.wikipedia.org/wiki/Apple_Disk_Image
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iPad                             
Make text more readable—  
by Macworld’s Lex Friedman

minia few fasteners, such as screws. At the 
end, layers, such as the display and glass, 
are added on top and sealed in another 
automated operation.
	 “Finally, the product is packaged and 
packed into cases for shipping, again 
with robots,” Sweet said.	 The impor-
tance of robots in warehouse distribution 
was illustrated in March, when Apple’s 
tablet-making rival Amazon announced 
an agreement to buy Kiva Systems, a 
company that also makes autonomous 
mobile robots to work in warehouses, for 
$775 million.
	 Apple CEO Tim Cook has not said 
whether Apple’s manufacturing plant 
will build products from scratch or as-
semble materials. Some see this relative-
ly small manufacturing investment as an 
effort to counter criticism about the com-
pany’s reliance on China, where it now 
makes its products. Apple’s revenues are 
at $156 billion.
	 But it may be shortsighted to dismiss 
what Apple is doing as a public relations 
move.
	 Whatever Apple builds, “you can guar-
antee it will be using the most up-to-date 
and modern factory automation equip-
ment that one can buy,” said Robert 
Atkinson, president of The Information 
Technology & Innovation Foundation 
and author of Innovation Economics: The 
Race for Global Advantage.
	 Atkinson said Apple will build a lead-
ing facility partly because it’s Apple, but 
also because of the relative high cost of 
U.S. labor. “You’ve got to use automation 
more than you might in China,” he said.
“One of the potentially significant things 
about the Apple announcement is it 
could send a message to American com-
panies--you can do this--you can make 
this work here,” Atkinson said.
	 Michael Palmer, an IDC analyst who 
researches electronics manufacturing, 
said that by having a manufacturing 
plant in the U.S., Apple will save on ship-
ping costs and shorten the time a prod-
uct is in inventory.
	 Palmer also pointed out that labor 
costs in electronics manufacturing are 
already relatively low, about 8 percent 
of the total manufacturing cost. “It’s all 

about having volume,” he said.
	 In the mid-1990s, Apple did make 
products in the U.S., and Jim Daly, manu-
facturing expert, helped to set up one of 
their plants.
	 Apple originally built a factory that 
was highly automated, but it wasn’t flex-
ible and couldn’t adapt quickly to chang-
ing needs. At the time, Daly was working 
for a contract manufacturer that was 
hired by Apple, which quickly set up a 
factory to build two models of the Mac. 
That plant relied more on labor and less 
on automation to get its flexibility, he 
said.
	 Today, Daly is vice president of manu-
facturing and operations of Rethink Ro-
botics, which makes robots for manufac-
turing. These robots are designed to be 
flexible enough to adapt to fast-chang-
ing manufacturing requirements.
	 But Rethink Robotics also has a story 
to tell about U.S. manufacturing. Over 
his career, Daly has set up manufactur-
ing operations in the U.S. and in Asia, and 
“what we found is there are some really 
competitive companies here.”
	 Rethink doesn’t manufacture or as-
semble its robots, but works closely with 
suppliers in the design process and then 
orchestrates the integration and assem-
bly, Daly said.
	 “All the plastics, all the metal, the tub-
ing, the gearboxes, the circuit boards are 
all manufactured in the U.S.,” he said. 
“U.S. supplier quality and efficiency, 
quite frankly, can be much higher” than 
in lower-cost overseas regions of the 
globe, said, Daly. “Low cost labor hides a 
lot of sins.”  M
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Struggling to read small text on your iPad 
mini? There’s a fix for that.  
Watch the video— or read the following:
The iPad mini is, of course, smaller than the 
9.7-inch versions of the tablet. And while 
that makes the iPad mini more portable, the 
scaled-down screen size also means that, in 
some cases, text can look awfully tiny. Luckily, 
there are workarounds.
	 If you find that your email, notes, address 
book, or iMessages are too tiny to read com-
fortably on your new iPad mini, there’s a po-
tential workaround you can try.
	 Launch Settings, tap on General, and then 
Accessibility. Next, tap the Large Text button 
and choose a font size.
	 Now, messages in Mail, notes in the Notes 
app, the texts you receive in Messages, and 
the contacts in the Contacts app will all use 
your larger font. (iOS says that Calendar 
should benefit from the font-size change too, 
but in my testing, that’s just not the case.)
	 Now, this change won’t make all the small 
text on your iPad mini bigger. Notably, the 
brief excerpts on display in the sidebars for 
Mail and Messages won’t get any larger, and 
that text is pretty tiny. And third-party apps 
won’t be aware of your text setting, either.
	 The good news is, most apps that are 
reading-centric will offer built-in text sizing 
options of their own. That’s true for Kindle, 
iBooks, Instapaper, The Magazine, and many 
more. Though the interface for tweaking 
per-app font sizes can change app to app, in 
general, you’ll want to poke through an app’s 
settings, and look for these A/A buttons. Tap 
the larger A to increase the app’s font size.
	 Remember too that you can zoom almost 
any text on your iPad. So as you’re reading an 
email message for example, reverse-pinch 
with two fingers to magnify the text tempo-
rarily.
	 So if you’ve been struggling to read text 
on your iPad mini, with luck these tips will 
prove helpful.  M

http://www.macworld.com/article/2013669/make-text-more-readable-on-your-ipad-mini.html#tk.nl_mwbest
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Review: Evernote 5.0 
for Mac improves an 
already indispensable 
service

Tom Negrino, via Macworld.com

That interesting Web article. The emailed or-
der for your new Mac. The snapped picture 
of the label as a reminder of that terrific pinot 
noir you just drank. A quick audio note you 
make with your phone. Those hundreds of 
downloaded PDFs of bank, brokerage, and 
utility company statements. You’ve got the in-
formation—heck, you’re practically drowning 
in it. Now you need somewhere to put it. You 
need an Everything Box. That’s a program 
that can store and sort those clippings and 
files, index them for easy search and retrieval, 
and allow you to add your preferred organiza-
tional structure as well, whether it be to group 
similar kinds of information into collections, 
or add metadata such as tags or categories.
	 Evernote is an Everything Box, as are other 
familiar Mac programs, such as Devon Tech-
nologies’ DevonThink, Bare Bones’ Yojimbo, 
and Chronos’s SOHO Notes, to name just a 
few. Where Evernote differs is that it’s free 
(with a paid Premium tier providing extra fea-
tures), available for Mac and Windows and as 
a Web app, and it has native iOS and Android 
apps. Evernote automatically uploads every-
thing you put into it to the company’s serv-
ers, making it available for syncing to all your 
devices. Evernote 5 is a major refresh of the 
program’s look and operations, and makes 
the service easier to use and more appealing 
than ever.

See Your Notes Your Way: Evernote 5’s clean new 
interface includes notes presented in this new Card 
view, which gives you a nice preview of each note, 
with the main content in the large pane on the right. 
This shot also shows, at left, the new Shortcuts and 
Recent Notes, which give you quick access to your 
pinned and latest notes, respectively.

How Evernote works—
The basic unit of information in Evernote is 
the note. You can collect similar notes in a 
notebook, creating as many notebooks as 
you need, or throw everything in one main 
notebook. You can add tags to notes to 
help categorize them further, and when you 
search for a tag, it finds notes with that tag 
in all notebooks. If your new item is a picture 
with words in it, Evernote will run optical 
character recognition on its servers to make 
the picture’s text searchable (even if the text is 
handwriting); the text then gets synced down 
to your Evernote clients with the rest of the 
note.
	 Evernote gives you many ways of captur-
ing new notes. You can type text notes direct-
ly in an Evernote client, or drag text, images, 
sounds, or videos into the program. You can 
also use the Evernote Web Clipper, an exten-
sion for Safari, Chrome, and Firefox, to snag 
all or part of Web pages. You can even email 
notes to Evernote. On the desktop, a menu 
bar extra allows you to create a new note, 
an audio note, or a screenshot, paste 
whatever’s on the Clipboard, and 
search the program.
	 The Mac client allows you to use 
your FaceTime camera to snap pic-
tures (but not video) of yourself or 
anything else you hold up to the cam-
era. Both the Mac and iOS versions of 
Evernote record audio notes, but they 
are low-quality (with a sample rate of 
just 8 kHz), mono WAV files, optimized 
for small file size and speech quality. 
It’s understandable that the company 
wants to keep files that will be synced with 
mobile devices small, but it would be nice to 
have an option for higher-quality audio, even 
if that would just be for Premium accounts.
	 Evernote 5.0 for Mac gives the program a 
major refresh. The left column has sections 
for Notes, Notebooks, Tags, Atlas (a view that 
uses geotags in your notes, especially images, 
to show on a map view where that note was 
created), and Trunk (more about that later). 
New to the program are two areas at the top 
of the left column: Shortcuts, where you can 
pin frequently used notes; and Recent Notes, 
which gives you quick access to your latest 
work. You can right-click on Notebooks or 
Tags to show their contents in the left column, 

as in previous versions of the program.
	 In the main part of the program window, 
where you view notes, are new Card and Ex-
tended Card views, and you can view notes 
by Notebook or Tag without doing a search. 
Speaking of which, searching for notes has 
been extensively improved, with type-ahead 
search that tries to anticipate your search 
string, and allows you to use note attributes 
as search tokens. As before, you can save 
searches for later use (now a smoother pro-
cess). The note editor gains a bunch of small 
changes that make it easier to write with; you 
can choose a plain-text note or add basic for-
matting, including full-screen composition.
	 I had a few minor issues with Evernote 5. 
Notes on one of my Macs did not sync at the 
set interval; I had to sync manually until I un-
installed and reinstalled the program on that 
Mac. I also had trouble searching on a par-
ticular tag, but while writing this review, two 
minor updates with bug fixes and a few new 
features were released, and the tag problem 
went away.

Where’s That Note?: The new Atlas view shows you a 
note’s original or source location, if it’s tagged with 
geographic information. You can get a preview of 
the note right in the Atlas.

The Trunk: extending Evernote
One of the most useful things about Ever-
note is the huge ecosystem that’s sprung up 
around it, consisting of hardware, software, 
and services that all use Evernote as their hub; 
Evernote calls its built-in access to these add-
ons the Trunk. Some of these are owned by 
Evernote itself: for example, in 2011, Evernote 
acquired Skitch, a popular screen capture and 
annotation tool, which is now integrated with 
the Evernote program, with Skitch images
—Continued on page 5

http://evernote.com/
http://www.macworld.com/article/1161735/review_devonthink_pro_office_2_2_1_helps_manage_your_data.html
http://www.macworld.com/article/1154505/yojimbo3mac.html
http://www.chronosnet.com/Products/sohonotes.html
http://evernote.com/skitch/
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Evernote Review– concluded
syncing to an Evernote notebook. Other Ever-
note tools include Hello, a mobile app that 
makes it easier for you to remember people; 
and Penultimate (another acquisition), an 
iPad notebook app that works with Evernote’s 
handwriting recognition.
	 But many other companies and develop-
ers work with Evernote. Numerous scanner 
manufacturers now have a scan-to-Evernote 
feature in their drivers. The Trunk lists dozens 
of mobile apps that enhance Evernote in one 
way or another; in addition, there are paper-
less services such as FileThis, which automati-
cally connects to and downloads statements 
from credit card, brokerage, and utility com-
panies and sends them to Evernote.
The price is right
The Evernote basic service and clients are 
free, and most users will be satisfied with that 
service (I used it for more than two years as 
a free account). The company says that ap-
proximately 96 percent of its users are free 
account members, who may upload up to 
60MB of data per month (data can be of any 
type). Small ads appear in the client programs 
for free users.
	 Advanced individual users can pay $5 per 
month or $45 per year for Premium features, 
such as a 1GB monthly upload quota; a ca-
pability to recognize text in PDFs and make 
it searchable (this feature, combined with 
my Fujitsu ScanSnap desktop scanner and 
a fervent desire to go paperless got me to 
upgrade to Premium); offline notebooks for 
mobile devices; shared notes and notebooks; 
the ability to hide the ads; and a few other fea-
tures.
	 The paid Evernote Business service ($10 
per user per month) adds still more features 
for managing employee accounts and shared 
business notebooks and notes. Employees 
can keep their personal notebooks separate 
from their company notebooks.
Bottom line
Evernote 5 is a major refinement to an already-
good client for the Evernote service. The re-
lease of the Mac client roughly coincided with 
new versions for iOS as well, refreshing the 
entire experience. Whether you are among 
the large majority of free users of the service, 
or use an Evernote Premium account, you will 
benefit from the new client programs.  M

Sharpened enough? Results 
may vary.
Recently, NC was working on a project that 
was to incorporate a City of Ocala logo. The 
image was a very small detail cropped out of 
a much larger photo scene while working in 
iPhoto. As you can see in the screen shot 1 
opened in iPhoto, the image content was very 
fuzzy and barely recognizable. Obviously, this 
image was going to need considerable sharp-
ening to be useable. Sharpening of 100% and 
Definition of 100% were applied in iPhoto 
resulting in preview shown in screen shot 2. 
A slight improvement over shot 1 but no-
where near it needs to be.. . or so he thought.
	 Although frustrated by what the iPhoto 
screen revealed as a preview of the sharpened 
image, he saved the image. NC then opened 
the original unsharpened but cropped image 
in Photoshop Elements (PSE)  [see shot 3]. 
The PSE version without editing is consider-
ably better than when viewing in iPhoto (see 
1 above). PSE’s “auto sharpen” function was 
used in shot 4. Better, but not quite there yet.
	 PSE’s sharpening capability also has the 
“unsharp mask” function using three con-
trols, one for amount of sharpening desired, 
another for radius desired and threshold.  
(Radius determines how many pixels out from 
the edge that the sharpening will effect and 
threshold determines how different a pixel 
must be from the surrounding area before it 
is sharpened.) This technique was used giv-
ing complete control over the amount of the 
sharpening result and, unlike iPhoto, a reliable 
preview and not guesswork [see shot 5].
	 But wait... we’re not done with the story. 
When NC went back and opened the sharp-
ened and saved iPhoto version, he found a 
contradiction to the saying “what you see is 
what you get” (see shot 6). In this case iPhoto, 
contrary to its preview (2), gave a nicely sharp-
ened result after all.
NC’s final comments are: “iPhoto is faster to 
use than PSE but with this difficulty of imme-
diately seeing the effect of my changes, I will 
be careful as to when I will use it in the future. 

MEMBER’S  SHOWCASE
Equipment & Software used:
Mac computer, iPhoto 11, Photoshop Elements 10 software

PSE final                                   iPhoto final

The iPhoto sharpening preview (2 above)  
is a definite problem”.  M

1

2

3

4
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http://evernote.com/hello/
http://evernote.com/penultimate/
https://filethis.com/fetch/
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Why So Many People Love  
Posted by Matt Kloskowski on CreativePro

Landscape Photography
Ever hear about (or see) one of those 

popular landscape photography lo-
cations that’s absolutely packed with 

people? Ever wonder why everyone is stand-
ing there taking the same exact photo that 
maybe tens of hundreds of thousands of pho-
tographers have taken before? If you haven’t 
witnessed it personally, then you’ve probably 
seen it pictured. And if you haven’t, then just 
check out the photo above taken at Delicate 
Arch in Arches National Park near Moab, Utah. 
Believe it or not, you’re not even seeing the 
other 50+ people that were to the right of me 
in that photo. So with crowds often like this, 
and so many photos looking similar to each 
other, why do so many people love landscape 
photography?
	 Landscape photography is sometimes like 
photo collecting. Look at the Story Behind The 
Photo— it’s the journey that it took to cre-
ate the image. We’ve probably all been to 
crowded photo locations where often many 
photographers are trying to take the same 
photo. So why don’t we just skip that location, 
admire someone else's, or buy a gift shop ver-
sion instead of trying to make our own? Be-
cause making our own photo of a beautiful or 
memorable place is part of photography. I’ve 
personally seen many great photos of Monu-
ment Valley. And honestly, I’ve seen many 

greater than mine. But I consider my trip an 
absolute success because I got to shoot Mon-
ument Valley the way I wanted to. I can still ad-
mire other’s photos of the area, but now I also 
have my own – and that means a lot to me. I 
was there. I got to feel what it was like. I got to 
experience the scenery, the air, the beautiful 
color in the sunset/sunrise, and the feeling of 
taking my own photo there. Plus, I got to put 
my own spin on the post-processing (which 
regardless if anyone admits it is a HUGE part 
of landscape and outdoor photography).

	 That’s what it’s all about and that’s why I 
have absolutely no problem walking up to a 
location that’s been photographed a million 
times before, and taking my own photo there. 
Do I love hiking out into the wilderness and 
capturing places few ever get to see? Sure I 
do. But a beautiful place is a beautiful place 
whether I had to hike for hours and camp 
overnight to get it, or I walked 15 feet out of 
my car and set my tripod next to 10 other 
photographers.  M

Four power tips for Safari 6
Sharon Zardetto, via Macworld.com

How often do you use your Web browser? If 
the answer is constantly, then a few choice 
tips could save you loads of time and trouble. 
Here are some for Apple’s Safari 6.
1. Cut through your bookmarks clutter—
Overwhelmed by bookmarks? The first step 
is to organize them into folders (Bookmarks 
> Add Bookmark Folder). The next step is to 
organize the bookmarks  within the folders. 
It’s not hard if you use the Finder to alphabet-
ize them.
	 Go to your bookmarks window (Book-
marks > Show All Bookmarks or Command-
Option-B), and drag a folder from the Book-
marks sidebar to the Desktop. This action 
copies the folder to the Desktop, and the con-
tents automatically sort by name.

	 You can’t drag a folder directly into the 
Safari sidebar; so, instead, drop your sorted 
folder into the list area of the Bookmarks win-
dow, and then drag it from there to the side-
bar. Unlike in the Finder, folders with the same 
name can exist in the same location in Safari, 
which means now you’ll have two. After you 
place the organized folder, delete the original.
2. Easily share pages through email—
Safari 6 makes it simple to share content you 
see on the Web. Click the new Share button 
in the Safari 6 toolbar to do so quickly. There 
you have the option to email the page, add a 
bookmark, add the page to your Reading List, 
or send a link to it through Message, Twitter, 
or Facebook.
	 If you tend to email webpages, you might 
think this button offers little advantage over 
the File > Share submenu. When you use that

Selecting ‘Email this Page’ from Safari 6’s Share  
button menu (or from the File menu’s Share  
submenu) sends you to Mail.           Go to page 7>>>
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.. menu, you can choose between mailing a 
webpage or just its link by pressing the Shift 
key while selecting. (If you’re using keyboard 
shortcuts, press Command-I or Command-
Shift-I, respectively). But no matter how you 
start, you wind up in Apple’s Mail, where you 
can change your mind about how to send the 
page and choose from two more options.
	 In Mail, look above the message area to 
see the easy-to-miss ‘Send Web Content As’ 
menu on the right. This menu lets you send 
the webpage itself, a link to the page, a PDF of 
the page, or a version that matches what you 
see in Safari’s Reader window (View > Show 
Reader). The Reader version includes easy-
to-read type, no ads, and multipage articles 
threaded together in a single document. 
The application  remembers the option you 
choose for the next time you use the Share 
command. Note that the Reader option isn’t 
available for all webpages; if View > Show 
Reader works on the page in Safari, you’ll be 
able to send it that way, too.

In Mail, use the “Send Web Content As” menu 
(circled) to choose how to send the webpage.

3. Get what you want with modified clicks 
on links—
Safari has long let you Command-click a link 
to open it in a tab. (This default behavior is 
set up in Safari > Preferences, under the Tabs 
pane.) Safari 6 adds two new link-clicking op-
tions: Shift-click to send the linked page to the 
Reading List, or Option-click to download it to 
your Downloads folder. But that’s just basic 
information.
	 Here’s the tip: Watch the status bar at the 
bottom of the window (choose View > Show 
Status Bar if it’s not there) to check what your 
modified click will do. This crib sheet is espe-
cially helpful when you’re adding the Shift 
key to a window– or tab-opening click to 
toggle between having the link open in the 
foreground or the background. There are a lot 
of modifier options to remember. If you give 
up on learning your modified-click behaviors 
even with the status-bar crib sheet, you can 
always Control-click a link to see a list of op-
tions.
4. Reverse your ‘never save password’ 
decision—
You enter a password for a webpage, Safari 
asks if you want to save it, and you click ‘Never 
for this Website’. But what if you have second 
thoughts? You can rescind your decision be-
cause, although the password wasn’t saved, 
your “never” choice was. Choose Safari > Pref-
erences, and click the Passwords tab. Select 
the site in the list (it will say ‘Passwords Never 
Saved’ in the User Name column) and click the 
Remove button. Visit the site again, and this 
time let Safari remember your password.

ly using for your iPhoto images is sufficient, 
but during the process of creating multiple 
libraries, you’ll be duplicating some iPhoto 
master images. This can require a great deal 
of storage space, depending on the format 
the masters are stored in (JPEG, TIFF, or RAW).
	 After you finish creating multiple libraries, 
and you’re satisfied with the results, you can 
delete the duplicates, but until then, you’ll 
need the extra storage space.
An organizational plan. Before you begin, 
you need to have a good idea of how you will 
organize your images into multiple libraries. 
Since iPhoto can only work with a single li-
brary at a time, you need to decide in advance 
how you’re going to divide up your images. 
Each library should have a specific theme that 
doesn’t overlap other libraries. Some good 
examples are work and home, or landscapes, 
vacations, and pets.
Plenty of free time. While creating libraries 
and adding photos is a relatively speedy pro-

The status bar tells you what will happen when you 
click a link. At the top is an unmodified click: The 
destination page will fill the current window.

Editors note—  Space did not permit large scale 
screen captures to be shown. For a step-by-
step explanation with video go to the original 
story on the web. Ignore the brief commercial 
that may appear in the beginning of the video. 
Sharon’s “how-to” will follow.  M

cess, it can take a fair amount of time to come 
up with a good organizational plan. It’s not 
uncommon to go through multiple iterations 
of a library structure before hitting on the one 
that feels right. Remember: Until you’re sure 
you’re satisfied with the results, don’t delete 
the duplicate masters stored in your original 
iPhoto library.
	 With the above as background, let’s get 
started with creating and populating multiple 
iPhoto libraries.

Editor’s Note— Now that Tom has whet your 
appetite, get the complete 5-page story in 
“How-To” format by following this link.  M

	 You can also save time, because the time it 
takes to scroll though a large library of images 
can be considerable. And while Albums and 
Smart Albums can help with organization, 
you may find that it takes even longer to find 
an image when you have to try to figure out 
which of your many albums contains the im-
age.
	 Multiple libraries can also help you focus 
on the topic at hand, instead of being distract-
ed by unrelated images.
Multiple iPhoto Libraries - What You Need
To create multiple iPhoto libraries, you’re go-
ing to need the following:
Plenty of storage space. You might think 
that the amount of drive space you’re current-

iPhoto Libraries By Tom Nelson, About.com

By using multiple libraries, you can reduce 
the total number of photos iPhoto has to 
load, thus ensuring snappier performance.

An iPhoto library can hold up to 250,000 pho-
tos. That’s a lot of images; in fact, it’s so many 
that you may wonder why you’d ever need to 
break your existing iPhoto library into mul-
tiple ones. The answer is, you probably don’t 
have to break single library up, but you may 
want to do it anyway, to better organize your 
images or to improve iPhoto’s performance. 
By using multiple libraries, you can reduce the 
total number of photos iPhoto has to load, 
thus ensuring snappier performance.

iPhoto Libraries— Create & Populate Additional iPhoto Libraries

http://www.macworld.com/article/2021320/four-power-tips-for-safari-6.html#tk.nl_mwbest
http://www.macworld.com/article/2021320/four-power-tips-for-safari-6.html#tk.nl_mwbest
http://macs.about.com/od/appleconsumersoftware/ss/Iphoto-Libraries-Create-And-Populate-Additional-Iphoto-Libraries_2.htm
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Disclaimer—  
The Apple logo is the property of Apple, Inc. The Windows logo is the property of Microsoft, Inc. All tradenames, trademarks, and registered  
trademarks used herein are the property of their respective owners or companies. The information presented in this newsletter is for the  
personal enlightenment of OMUG members and friends, does not constitute an endorsement, and is not to be used for commercial purposes.

Announcements & Introductions:  Meeting called to order at 7 pm by President N.C Sizemore who welcomed 
18 members including 3 new. N.C. reported on the very successful Christmas party at which we were treated to 
Pizza, and music performed by J. P. Leemans and friends. The Board of Directors presented a gift certificate to 
Phil Davis in appreciation for all the work he does for our members.

Secretary’s Report: Minutes of the November meeting were approved as published.

Treasurer’s Report: Brian reported that the bank balance was $913.00.

Program:  Evernote– Create Your Own Knowledge Base— Presenter: Phil Davis

Phil is dragging us kicking and screaming into the 21st Century as his presentation on Evernote shows. This 
is a knowledge based program for saving, storing and accessing the various pieces of information we have 
on all our Mac devices. An important distinction to remember is: data=numbers (2,2) , knowledge= what 
we do with those numbers (2+2=4). Evernote is free. One caveat; do not store passwords, financial infor-
mation or email addresses as this will not be protected. The links to Phil’s presentation are posted on the 
web site as usual.

Break: We enjoyed refreshments provided and served by Della Marteny and chocolate from Bob Holloran..

Tech Tips:  New member Lloyd Miner jumped in right away to present a tip on using App Cleaner to remove 
all the background information when you delete an application. Merely dragging it to the trash will not ac-
complish this and App Cleaner is quick, thorough and free!   It is available at www.freemacsoft.net/Ap-
pcleaner.net. He also showed us how to use colors to identify incoming mail on MacMail by adding a rule.
Next Month: Jonathan Muse, the Apple representative from Best Buy, will present a program on iCloud and 
security.

Raffle Results: $20.00 to Brain Voge

2-gig Thumb Drive - Marilyn Kennedy  •  ebook Take Control book of your choice - Marilyn Kennedy  •  Chargers 
for iPhone and iPad (2) Jerry Guttman and J.P. Leemans  •  DVD The Snows of Kilamanjaro - Nancy Kirby

Meeting adjourned at 9 PM. Thanks to all who helped clean the meeting room and put chairs away.

Respectfully submitted:  Nancy Kirby, OMUG Secretary

OMUG MEETING MINUTES: January 8th, 2013, called to order at 7 PMOMUG Meeting Information—

The Ocala Mac User Group meets on the  
2nd Tuesday of the month at:

St. George Anglican Cathedral—  
Parish Hall
5646 SE 28th St., Ocala, FL 34480 
See www.ocalamug.org for a map

OMUG Board of Directors—
President– N.C. Sizemore 
ncsizemore@gmail.com • 291-8778 
Vice President– Bobby Adams 
badams0993@gmail.com • 274.0177 
Secretary– Nancy Kirby 
nkirby1944@embarqmail.com
Treasurer– Judy Rankin  
judyrankin@mac.com • 821-2322 
Director– Brian Voge 
voge.brian@gmail.com • 622-8581  
Director– Philip Davis 
davistech@gmail.com • 369-8432
Director– Burt Stephens 
burtstephens@gmail.com • 873-6177  
Director– Al Sypher 
aes@imageocala.com • 237-9501
Past President– Tim Rankin 
rank.tim@gmail.com • 821-2322

Mac Users Helping Mac 
Users—
OMUG Tech Support Team volunteers 
will try to help with your computer and 
software problems.
Please go to http://ocalamug.org/
tech-team.html for a list of help topics 
and phone/email contacts for the 
following member volunteers:  
Bob Adams  
Philip Davis (email ONLY) 
Nancy Kirby 
Dr. Roberto Putzeys 
Judy Rankin 
Tim Rankin 
Brian Voge

OMUG Assignments—

Fifty-Fifty Raffle– Earl Satterfield 
Membership– Nancy Kirby 
MUGSHOT Newsletter– Al Sypher
Program Coordinator– Burt Stephens
Refreshments– Della Marteny and  
Ed Jaworowski
Webmaster and Apple Ambassador–  
Philip Davis
Brian Voge– Assistant Treasurer

Next Workshop—

Feb. 16th: Using Keynote, presented by 
Burt Stephens. 
10 AM to 12 PM

Workshop Notes— January 19, 2013

Phil did a quick review of Evernote, a cloud-based knowledge organizer, and demonstrated a couple of useful 
features such as the ability to post notes to Evernote using Email.
	 Phil demonstrated several knowledge organizer applications. He suggested that you should download 
“Trial” versions of each before purchasing. Each program has advantages and it is suggested that you learn 
more about them before committing your dollars. Except for nvALT, they are not free, but reasonably priced. 
Once you make your selection you should spend time mastering it. 
	 Phil suggested that you create a knowledge base with your important information and keep a current 
copy on a thumb drive along with a copy of the program used to create it. This makes it easy to grab in case 
of an emergency, such as a fire.
	 A copy of the workshop notes and information on MacJournal, DevonThink, Yojimbo, and nvALT is avail-
able on the web site. There is also a copy of a sample knowledge base in MacJournal format available for 
download.  — Nancy Kirby, OMUG Secretary

Oh... and one last thing— In everyone’s life, at some time, our inner fire goes out.
It is then burst into flame by an encounter with another human being.
We should all be thankful for those people who rekindle the inner spirit.
        —Albert Schweitzer

This month’s cover pic is presented as a public service to those OMUG member’s who may have forgotten what it’s like for 
much of the  rest of the nation at this time of year (B-R-R-R) . Location: N. Carolina Blue Ridge — photo by  Al Sypher

http://www.ocalamug.org
mailto:ncsizemore@gmail.com
mailto:nkirby1944@embarqmail.com
mailto:judyrankin@mac.com
mailto:voge.brian@gmail.com
mailto:burtstephens@gmail.com
mailto:aes@imageocala.com
mailto:rank.tim@gmail.com
 http://ocalamug.org/tech-team.html
 http://ocalamug.org/tech-team.html
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